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Zeiss Axio Zoom V16 - Users’ Guide 

 

Author(s): Fernando Cruz; Mariana Ferreira Date: June 2020 

 

Purpose: Zeiss Zoom V16 is a zoom microscope that successfully combines a large field of view, 

zoom, and working distance. Its 1x objective has a 0.25 numerical aperture (NA), a considerable NA 

for a medium zoom range allowing for superior fluorescence brightness in large object fields. The 

Axio Zoom V16 is the fluorescence zoom microscope fully automated for large field visualization 

having a motorized zoom from 7x to 112x, motorized Z focus and easy-to-use system control panel.  
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Safety instructions and contacts 

Safety instructions and first aid procedures 

Specimens should be sealed before observation under the microscope and handled with care using 

the appropriate level of protection.  

- Leaky or cracked samples must not be examined.  

- Any spillages should be cleaned up immediately and the area swabbed with 95% alcohol.  

- Glass slides should be disposed of in the contaminated sharps bin – broken fragments of 

glass should be brushed on to paper and disposed of in a similar fashion.  

All biological samples and hazardous waste must be appropriately disposed of by the user. Potential 

risks associated with the waste material should be addressed by the user in conformity with ITQB-

NOVA rules.  

Contacts 

Mariana Ferreira, Bacterial Imaging Cluster (mariana.g.ferreira@itqb.unl.pt) 

Adriano O. Henriques, Microbial Development Group (aoh@itqb.unl.pt)  

Mónica Serrano, Microbial Development Group (serrano@itqb.unl.pt) 

Pedro Matos Pereira, Bacterial Cell Biology Group (pmatos@itqb.unl.pt) 

 

Phone +351 214 469 524 Extension 1522/4 or 1566/7 

 

Online information: http://www.itqb.unl.pt/bic   
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Equipment location, description and technical specifications 

Location: Room 5.25 (Bacterial Imaging Cluster), 5th floor, Instituto de Tecnologia Química e 

Biológica António Xavier (ITQB NOVA) 

Manufacturer: Zeiss 

Model: Zeiss Axio Zoom.V16  

Year Installed: 2016 

 

Potential Techniques 

 Large Sample Observations 

 Time-lapse 

 Dark Field Microscopy  

 

Features and Specifications 

 Focus Motor 3 with Central Profile Stand 

 Transillumination Base 300 

 Controller EMS 3  

 Sycop System Control Panel 

 Motorized Reflector Module Z FL w/ ACR (Automatic Component Recognition)  

 Camera: AxioCam 503 Mono 

 Eyepieces: PL 10x/23 Br. Foc. (High eyepoint and Focusing) 

 

Transmitted Light Techniques 

 Dark Field 

 Bright Field 

 

Incident Light 

 Fluorescence: HXP 200C Illuminator (w/ 200 W mercury short-arc reflector lamp)   
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Objectives 

Magnification1 1x 

ZEISS System Plan-Neofluar Z 

Class 
Colour and Chromatic 

Correction 

Numerical Aperture 

(NA)2 
0.25 

Immersion Air 

Free Working Distance 

(mm) 
5.6 

 

1Notice that the microscope is equipped with two Eyepieces: PL 10x/23 Br. Foc 

2 NA - Numerical Aperture. For more information, follow this link. 

 

- Remember to choose the proper calibration if doing montages/size measurements. 

- The pixel size in microns of your picture is saved automatically (if you've chosen the correct calibration). Use 

LOCI to recognize it with ImageJ. 

- The pixel size in microns of your picture is saved automatically when using Zen. Use Bio-formats to recognize 

it with ImageJ/Fiji (already installed in the Fiji package).  
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Filter-Sets for Incident Light 

 

Position Filter Cube Excitation Filter Dichroic Mirror Emission Filter Emission Colour 

1 HE GFP BP 470/40 495 BP 525/50 Green 

2 HE YFP BP 500/25 515 BP 535/30 Green/Yellow 

3 HE mRFP BP 565/30 585 BP 620/60 Red 

4 Empty - - - - 

BP - Bandpass Filter 

HE – High Efficiency Filter 

 

Computer 

 Type: Desktop 

 Brand: ASUS® 

 Model: i9S 

 Features: Intel I5 4460 up to 3.2 GHz (Quad-Core); 8GB RAM; 1TB HDD 

 OS: Windows 7 Professional 

 Available Software: Zeiss Zen 2.1 

Monitor 

 Brand: Samsung® 

 Model: S24C250B 

 Diagonal: 24” 

 

Zen 2.1 (blue edition) 

 The ZEN 2.1 (blue edition) can be equipped with several modules, applications and 

licenses. This guideline is strictly specific for the ZEN 2.1 (blue edition) version available 

on the microscope’s computer.  
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Suggestion for description in “Materials and Methods”.  

Images were acquired on a Zeiss Axio Zoom.V16 stereo microscope equipped with a Zeiss Axiocam 

503 mono CCD camera and controlled with the Zeiss Zen 2.1 (blue edition) software, using the 1x 

0.25 NA objective, the fluorescence filter sets HE GFP + HE mRFP and the Bright Field optics .  

Information to be added to the “Acknowledgements” section. 

This work was partially supported by PPBI - Portuguese Platform of Bioimaging (PPBI-POCI-01-

0145-FEDER-022122) co-funded by national funds from OE - "Orçamento de Estado" and by 

European funds from FEDER - "Fundo Europeu de Desenvolvimento Regional”. 
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User pre-requisites, booking and general rules. 

 The equipment cannot be used without official training. 

 Before your first use contact Mariana Ferreira to schedule training. 

 New users must have a clear understanding of the principles of light microscopy and how 

fluorescence works.  

 Save all data into your own storage device as we routinely clean the computer’s data 

 Register your utilization in the logbook  

 For all downstream image analysis image analysis a free software license is available for 

ZEN lite at ZEISS website. Alternatively, you can use FIJI.  

 Contact the responsible people in case of any doubt or any issue with the equipment. 

 Booking is done online at the ITQB intranet. Please mind the following rules when booking 

the zoom microscope.  
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System Overview  
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System Protocols 

Start Up Procedure 

 

If you plan to use fluorescence and the lamp is turned off, ensure it has been off for over 

one hour and when you touch the right side of the lamp case it should be cool to the touch. 

 

1. Switch on the components in the following order: 

1.1. Incident Light Source HXP 200 C (Fluorescence Lamp) IF you need fluorescence 

1.2. Electronic Module EMS 3 

1.3. Computer 

 

2. Wait for the SYCOP 3 control panel to initialize 

3. Run ZEN (blue edition) on the computer and select Zen Pro  
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Check Before Use 

1. Pull the red STOP button on the left side to remove the warning message on the SYCOP 3 

screen and unlock system movement. 

 

2. Ensure the aperture diaphragm is completely open by turning the rotary knob, on the right-hand 

side of the microscope, up. You can check on the ZEN Blue software the open percentage. 

 

3. Open the slider and turn on the Transmitted Light source on the right side of the base and choose 

between the Bright Field (BF) and Dark Field (DF) condensers on the left side. 

4. On the right of the eyepieces check if the light is going to the eyepieces or the camera and adjust 

accordingly. 
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Shutdown Procedure 

 

1. Before starting the shutdown procedure check whether there are any users booked within 

an hour if so, leave the system on otherwise follow the shutdown procedure. 

2. Confirm you have saved all your images and close the ZEN (blue edition) software. 

3. Copy your data to a flash drive or external hard drive. 

4. Turn off the computer. 

5. Press the STOP button to lock the system movement. 

6. Turn off the transmitted light source if you turned it on. 

7. On the SYCOP 3 touchscreen Home tab press the shutdown button on the top right corner, 

select Yes and wait for the system to shut down. 

 

8. Finally turn off the Incident Light Source HXP 200 C (Fluorescence Lamp) if it was on. 
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Mounting a sample and acquiring images: 

Sample Preparation Notes 

 You can use resources such as the FPBase or the Thermofisher SpectraViewers to 

explore your fluorophores.  Learn their excitation and emission wavelengths, and what are 

their optimal filters! 

 This system is optimized for larger samples like bacterial colonies or seedlings. 

Zen 2.1 blue edition General User Interface 

The ZEN 2.1 (blue edition) can be equipped with several modules, applications and licenses. This 

guideline is strictly specific for the ZEN 2.1 (blue edition) version available on the microscope’s 

computer. 

The ZEN 2.1 user interface is divided into three main areas. Via the tabs in the Left Tool Area 

(4) you can access all the main tools for microscope control (Locate tab), acquisition (Acquisition 

tab), image processing (Processing tab) and image analysis (Analysis tab). The Centre Screen 

Area (5) is used to display your images, while the Right Tool Area (6) provides you with an overview 

of all open documents and is used for advanced file management. 
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Multidimensional Image Acquisition (Multi-Channel Images) 

1. Go to the Acquisition tab 

 

You can create a new blank experiment. Alternatively, you can use one of the pre-set 

experiments. Try to follow the protocol until the end and then look at the pre-set experiments that 

may be useful for your experiment. In this way, we can keep the workspace organized and without 

redundancy.  

 

You can use and alter the available pre-set experiments as long as those alterations are not 

saved at the end! We advise this option for short-term experiments 

 

2. To create a new, "empty" experiment, click in the Options  button of the Experiment 

Manager section. The Options dropdown list will open. 

 

3. Click on the New entry. 

4. Enter a name for the experiment, e.g. "experiment_number_channel" 

 

5. To create the experiment, click in the Save  button 



ITQB-NOVA – Bacterial Imaging Cluster 

                             
  

Page 14 of 34 

 

You have created a new blank experiment. For any change in the experiment, an asterisk (*) 

will appear after the file name. This means that the experiment was modified and not saved. Save 

your experiments from time to time to ensure that your settings are not lost.  

 

6. Start focusing the sample (See above Error! Reference source not found. -> Error! 

Reference source not found.) 

7. Now in the Multidimensional Acquisition group, click in the blue header of the Experiment 

Designer tool  

 

8. Make sure to box the Enable Multi Block Execution option 

 

9. In the Acquisition Block section, click in the Add New  button.  
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a) Add as many blocks as contrast methods/filter sets you would like to acquire. For 

instance, to acquire images of Bright Field, GFP, mRFP and YFP, four blocks must be added. This 

approach will generate one image for each contrast method and filter set.  

 

Later, you will be able to combine two images at a time into one using ZEN 2.1 (See Error! 

Reference source not found. -> Channel Combine or Image Overlay) 

 

b) Alternatively, you can add only one block. This approach will generate a multichannel 

image of all selected filter sets. Combine only filter sets into a single block though, as it is required 

one block for each single contrast method.  

 

In the end, you can extract individual fluorescence images of a multichannel image (See 

Error! Reference source not found. -> Extracting Single Fluorescence Images of a Multichannel 

Image) 
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c) If you have selected multiple contrast methods that require distinct illumination 

methods (e.g. Bright Field and Fluorescence), you must use the Wait block. To set a Wait block, 

just click in the Wait  button. 

 

As it is strictly required to operate the diaphragm slide between transitions of transmitted 

and incident light (e.g. from bright field to fluorescence GFP), the Wait block will make a pause 

during the experiment.  

At the pause, you should set the diaphragm slide in agreement with the next contrast 

method.   

To switch the order among blocks, just click in a block and move it into the desired position 

of the timeline of events. 

10. Box the 1 separate image document / acquisition block option to create an image for each 

block of the timeline of events 
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11. Select the first block in the timeline of events 

 

12. Now in the Acquisition Parameter group, click in the blue header of the Channels tool  

 

13. Click in the +  button to open the Add Dye or Contrast Method dialog 

 

14. Select the desired filter set (from the Dye Database) or contrast method (from the 
Contrasting Methods). You can search for a dye by entering its name (or starting letter) in the 
Search input field (See above the available Filter Sets).  
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15. Click in the Add  button at the bottom of the dialog or simply double-click an entry 

 

IF you have previously selected one single channel image per block, click in the Close button of 

the Add Dye or Contrast Method dialog and move to the next step. 

IF you have previously selected a multichannel image by setting only one block for acquiring 

multiple filter sets (multichannel image), repeat this step to add the remain channels. Close the dialog 

at the end. 
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16. Once you have selected a dye(s) or contrast method, one will be displayed in the Channels 

tool 

  

17. Set the Exposure Time for each channel, just right beneath the channels list. There will be 

more than one channel in a multichannel block. Thus, the Exposure Time should be set one channel 

at a time 

 

18. Repeat the steps 12-17 for the remaining blocks. Once you have finished assigning all 

channels and contrast methods, move to the next step    
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19. To save the experiment together with all the settings, click in the Options  button of the 

Experiment Manager section and select the Save entry 

 

!!! Save ONLY self-made-experiments!!! Do not save previously pre-set experiments, unless they 

are yours 

 

20. Finally, select the first block of the timeline of events (in the Experiment Designer tool) and 

click in the Start Experiment  button 

   

21. The last image to be acquired will be displayed in the Centre Screen Area. The remain 

images will appear in the right-side Right Tool Area 
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Channel Combine or Image Overlay 

1. Go to the Processing tab 

 

2. Click in the Single  button  

 

3. Click in the blue header of the Method tool 
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4. Click in the Utilities group to display the dropdown list of tools included in this category 

 

5. Search for the Add Channel tool and click in it 
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6. Click in the blue header of the Input tool 

 

7. Select images of channels you would like to combine. To do so, click in the small preview 

image within the Input tool. You will see a preview of all open images. To select an image, just click 

in it 

 

8. Yet in the Input tool, select the Switch to Output option only 
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9. Click in the blue header of the Output tool and select the Create New Output option only. 

Additionally, you can name the new image as you like by clicking in the Naming button 

 

10. Finally, click in the Apply  button. The image combined will be displayed 

in the Centre Screen Area.   
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Extracting Single Fluorescence Images of a Multichannel Image 

1. Select the Processing tab. Open the Method tool and under Utilities select the entry Create 

Image Subset  

 

2. In the Image Parameters group, open the Input tool and select the multichannel image as 

input  

 

3. In the Method Parameters group, open the Parameters tool and click in the Channels entry. 

For instance, deactivate the red and green/yellow fluorescence channels by clicking in the 

corresponding channels to extract only a single green fluorescence image 
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4. Finally, click in the Apply  button. The single channel image will be displayed 

in the Centre Screen Area 

 

Closing ZEN 2.1 

1. To end ZEN 2.1 software, go to File -> Exit. Alternatively, you can press ALT + F4 on 

your keyboard or click in the Close icon of the program bar. 

Note: If you haven’t saved your files, the Save/Keep Documents dialog will open before the program 

closes. Select files you want to save or unselect files you don’t want to save. 

 

Save only documents that are actually yours, and not pre-set experiments that belong to others or 

light path settings of the favorites filter sets. 

 

  

Images only created for 

testing purposes which 

can be discarded  

Experiment of another 

user which should not 

be saved! 
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Downstream Image Processing and Analysis 

A free software license is available for ZEN lite at ZEISS website 

(https://www.zeiss.com/microscopy/int/products/microscope-software/zen-lite.html). Install and use 

such version in your own personal computer for downstream image analysis  

Open 

1. Go to File -> Open  

 

2. Search for the .czi files previously saved in the directory dialog 

3. The selected files will be displayed in the Centre Screen Area and Right Tool Area 

 

Display Adjustments  

1. In the Dimensions tab of the Centre Screen Area, activate the Range Indicator checkbox. 

This will mark in red or blue overexposed (too bright) or underexposed (too dark) areas, respectively  
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2. On the Display tab click in the 0.45  button. The display curve will be adapted to a 

gamma value of 0.45. This will set the optimum colour presentation. If you do not see this button 

activate the Show all mode 

 

3. Move the controls left and right under the multiple curves in order to directly adjust the values 

for Brightness (White), Gamma, and Contrast (Black) in the live image 

 

1 - Contrast (black point) control 

2 - Gamma control 

3 - Brightness (white point) control 

 

 

 

 

1 2 3 
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Add Scale Bar or Arrows 

1. In the Center Screen Area, select the Graphics tab  

 

2. Click in the Scale Bar  or Draw Arrow  buttons. The scale bar will appear directly 

in the image and in the Annotations/Measurements as an entry. To set an arrow, the button will 

turn blue and then you can draw an arrow over the image  

 

You can access to numerous formatting possibilities by right-clicking in the annotation (scale 

bar, arrow, etc). This will open the context menu. Select Format Graphical Elements… in this dialog 
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Distance Measurements 

1. Go to Graphics -> Line  

 

2. Draw the line over the object you would like to measure 

3. In the Center Screen Area, select the Graphics tab. An entry of the Line type will appear 

together with the positions and sizes (these measurements are not the distance length between the 

two-point edges of the line) 

 

4. To display the distance length, box the M column and the measurement will be displayed in 

the image under the line 
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Cropping Region of Interest (ROI)  

1. Go to Graphics -> Draw Region of Interest 

 

2. Draw a square or rectangular region over the region of interest 

3. Right-click in the drawn region. This will open the context menu. Select Create Subset 

Images from ROI in this dialog 

 

4. The selected region will be displayed as a new image in the Centre Screen Area. Besides, 

the image document will appear in the right-side Right Tool Area 
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Export 

1. Go to the Processing tab 

 

2. Click in the Single  button  
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3. Click in the blue header of the Method tool 

 

4. In the Method tool, open the Export/Import group and select the Image Export method 

5. Under Method Parameters group, select the Parameters tool, and set the desired export 

settings, such as file type, quality, export folder, … 
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6. Click in the blue header of the Input tool 

7. Select the images you would like to export. To do so, click in the small preview image within 

the Input tool. You will see a preview of all open images. To select an image, just click in it  

 

8. Yet in the Input tool, select only the Switch to Output option  

 

9. Finally, click in the Apply  button. 


